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REMOTE CONTROL

Remote control (CI-V) information

< CI-V connection

The transceiver’s operating frequency, mode, VFO and memory selection, can be remotely controlled

using a PC.

The Icom Communications Interface V (CI-V) controls the transceiver.

Connect the transceiver to a PC with a USB cable (User supplied).

®Make the connection as short as possible. The transceiver may not be recognized by the controller, depending
on the USB cable length.

®When connecting to a USB port on your PC with the USB driver installed, USB (A) and USB (B) are named as
“IC-705 Serial Port A (CI-V)” and “IC-705 Serial Port B.”

The required USB driver and driver installation guide
can be downloaded from the lcom web site.
Go to “https://www.icomjapan.com/support/,” and

then click “Firmware / Software.”
® The download procedure on the web page may be
changed without notice.

USB cable
PC (User supplied)

@ O
To a USB port To the [microUSB] port

< Preparing

The Ilcom Communications Interface V (ClI-V) is used for remote control.
To control the transceiver, first set its address, data communication speed, and transceive function.
These settings are set in the Set mode (Refer to the IC-705 instruction manual).

<¢ About the data format

The CI-V system can be written using the following data formats. Data formats differ according to
command numbers. A data area or sub command is added for some commands.

Controller to IC-705 OK message to controller
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REMOTE CONTROL

Remote control (CI-V) information

¢ Command table

Cmd. | Sub cmd. Data Description Cmd. | Sub cmd. Data Description
00 See p. 16. Send the frequency data OE B1*2 Set as select channel
(transceive) ® The previously set number by
01 See p. 16. Send the mode data (transceive) 8le is fﬁ}laﬂerlt”:”g‘gf power
02*1 See p. 16. Read the band edge frequencies ' or . s selected it no
y - selection is performed.
03 See p. 16. Read the operating frequency 01~03 Set the channel as a Select channel
04*1 See p. 16. Read the operating mode (01=SEL1, 02=SEL2, 03=SEL3)
05*2 Seep. 16. | Set the operating frequency B2*2 00 ~ 03 Set the Select memory scan
06*2 See p. 16. Set the operating mode channel
07 Select the VFO mode (00=ALL, 01=SEL1, 02=SEL2,
03=SEL3)
00 Select VFO A
DO*? Set Scan resume OFF
01 Select VFO B
- D3*? Set Scan resume ON (Close&Delay)
A0 Equalize VFO Aand VFO B " - -
® When the split frequency OF 00 Read Split OFF setting
operation is OFF in the Memory 01*! Read Split ON setting
mode or the Call channel mode, 11*1 Read DUP- operation
FA" (NG) is returned. 12+1 Read DUP+ operation
BO Exchange VFO A and VFO B. 00%2 Set Split function OFF
® When the split frequency - - -
operation is OFF in the Memory 01 Set Split function ON
mode or the Call channel mode, 10*2 Set the simplex operation
“FA” (NG) is returned. 11*2 Set DUP- operation
08*2 Select the Memory mode 12%2 Set DUP+ operation
0000 ~ 0099 |Select the Memory channnel 10* 00~13 Send/read the tuning step
(Memory channel: 0000 ~ 0099 (00=OFF (10HZ or 1HZ)
Call channel: 0000 (144C1), 01=100Hz 02=500Hz
0001 (144C2), 03=1kHz 04=5kHz
0002 (430C1), 05=6.25kHz ~ 06=8.33kHz
0003 (430C2)) 07=9kHz 08=10kHz
A0 0000 ~ 0100 (Select the Memory group 09=12.5kHz = 10=20kHz
(Memory channel group: 11=25kHz 12=50kHz
0000 ~ 0099 13=100kHz)
Call channel group: 0100) 1* 00 Send/read attenuator OFF setting
09 Memory write 20 Send/read 20 dB attenuator setting
0A Memory copy to VFO @® You can set in the HF and
0B Memory clear 50 MHz bands.
oc*! See p. 16. Read frequency offset 13 00 Sspeech alll daltaf by voice syn(tjhesi(zjer
0D*2 See p. 16. Send frequency offset o (S met;ertheve . re(tq.uer}cy, andmo Z)
OE 00 Cancel the scan peech the opera 'T‘g requengy an
S meter level by voice synthesizer
o1 Start a Programmed/memory scan 02 Speech the operating mode by voice
02 Start a Programmed scan synthesizer
03 Start a 4F scan ® The mode is announced after the
12 Start a Fine programmed scan ongoing speech.
13 Start a Fine AF scan 14 01 0000 ~ 0255 Send/reqd .the AF level .
(0000=Minimum ~ 0255=Maximum)
22 Start a Memory scan -
02 0000 ~ 0255 |Send/read the RF gain level
23 Start a Select memory scan (0000=Minimum ~ 0255=Maximum)
24 Start a Mode Select scan 03 0000 ~ 0255 |Send/read the squelch level
Ax*2 Select AF scan span (0000=Minimum ~ 0255=Maximum)
(x=1~7) (x=1 (£5kHz),  x=2 (+10kHz), 06 0000 ~ 0255 |Send/read the NR level
x=3 (+20kHz), x=4 (+50kHz), (0000=0% ~ 0255=100%)
x=5 (+100kHz), x=6 (+500kHz), —
_ 07 0000 ~ 0255 | Send/read [TWIN PBT] (PBT1) position
x=7 (+1MHz)) )
- (0000=max. Counter Clockwise ~
B0*? Clear the Select channel setting 0128=center ~ 0255=max. Clockwise)
08 0000 ~ 0255 |Send/read [TWIN PBT] (PBT2)
position

(0000=max. Counter Clockwise ~
0128=center ~ 0255=max. Clockwise)




REMOTE CONTROL

Remote control (CI-V) information

¢ Command table

Cmd. | Sub cmd. Data Description Cmd. | Sub cmd. Data Description
14* 109 0000 ~ 0255 |Send/read CW pitch (5 Hz steps) 16* |22 00/01 Send/read the Noise blanker
(0000=300 Hz ~ 0128=600 Hz ~ (00=0OFF, 01=0ON)
0255=900 Hz) 40 00/01 Send/read the Noise reduction
0A 0000 ~ 0255 [Send/read the selected band’s RF (00=0OFF, 01=0ON)
power 41 00/01 Send/read the Auto Notch function
(0000=Minimum ~ 0255=Maximum) (00=OFF, 01=0ON)
0B 0000 ~ 0255 | Send/read MIC gain 42 00/01 Send/read the Repeater tone
(0000=Minimum ~ 0255=Maximum) (00=OFF, 01=0ON)
0C 0000 ~ 0255 | Send/read keying speed 43 00/01 Send/read the Tone squelch
(0000=6 WPM ~ 0255=48 WPM) (00=OFF, 01=0N)
oD 0000 ~ 0255 |Send/read Notch filter setting 44 00/01 Send/read the Speech compressor
(0000=max. Counter Clockwise ~ (00=OFF, 01=ON)
0128=center ~ 0255=max. Clockwise) 45 00/01 Send/read the Monitor [MONI]
OE 0000 ~ 0255 |Send/read the COMP level function
(0000=0 ~ 0255=10) (00=OFF, 01=0ON)
OF 0000 ~ 0255 |[Send/read the Break-IN Delay setting 46 00/01 Send/read the VOX function
(0000=2.0d ~ 0255=13.0d) (00=OFF, 01=0ON)
12 0000 ~ 0255 | Sendjread NB level 47 00 ~ 02 Send/read the BK-IN function
(0000=0% ~ 0255=100%) (00=BK-IN OFF, 01=Semi BK-IN ON,
15 0000 ~ 0255 |Send/read Monitor audio [MONI] 02=Full BK-IN ON)
level 48 00/01 Send/read the Manual Notch function
(0000=0% ~ 0255=100%) (00=0OFF, 01=0ON)
16 0000 ~ 0255 | Send/read the VOX gain 4B 00/01 Send/read the DTCS function
(0000=0% ~ 0255=100%) (00=OFF, 01=ON)
17 0000 ~ 0255 | Send/read the Anti VOX gain 4F 00/01 Send/read the Twin peak filter
(0000=0% ~ 0255=100%) (00=OFF, 01=0N)
19 0000 ~ 0255 [Send/read LCD backlight brightness (Can be turned ON only when Mark
(0000=0% ~ 0255=100%) and Shift are set to 2125 Hz and
151 |01 00/01 Read noise or S-meter squelch status 170 Hz, respectively)
(00=Close, 01=0pen) 50 00/01 Send/read the Dial lock function
02 0000 ~ 0255 |Read S-meter level (00=OFF, 01=0N)
(0000=S0, 0120=S9, 56 00/01 Send/read DSP IF filter type in the
0241=89+60 dB) operating band
05 00/01 Read various squelch (tone squelch, (00=SHARP, 01=SOFT)
and so on) status 57 00 ~ 02 Send/read the Manual Notch width
(00=Close, 01=0Open) (00=WIDE, 01=MID, 02=NAR)
07 00/01 Read the OVF status 58 00 ~ 02 Send/read SSB transmit bandwidth
(00=OVF indicator is OFF, (00=WIDE, 01=MID, 02=NAR)
01=0VF indicator is ON) (One of following values is applied,
11 0000 ~ 0255 |Read the Po meter level depending on the “COMP” status
(0000=0% ~ 0143=50% ~ 0213=100%) ﬁg Er SFF)i 4 1A 05 0017
12 0000 ~ 0255 |Read SWR meter level (Command: )
MID (Command: 1A 05 0018), or
(0000=SWR1.0, 0048=SWR1.5, NAR (Command: 1A 05 0019))
0080°5WR2.0, 0120=SWR3.0) 58 00 ~ 02 Send/read the DSQL (Digital Call
13 0000 ~ 0255 |Read ALC meter level o sljjeléh;CSC?L ((Di'gi't;al oo
(0000=Minimum ~ 0120=Maximum) 9 . 9
squelch) setting
14 0000 ~ 0255 |Read COMP meter level (DV mode 0n|y)
(0000=0 dB ~0130=15dB ~ (00=0OFF, 01=DSQL, 02=CSQL)
0210=25.5 dB) 5C 00 ~ 02 Send/read the GPS TX mode
15 0000 ~ 0255 |Read VD meter level (00=0OFF, 01=D-PRS, 02=NMEA)
(0000=0 V ~ 0075=5 V ~ 0241=16 V) 5D 00 ~ 03, Send/read the Tone squelch function
16 0000 ~ 0255 |Read ID meter level 06 ~ 09 (00=OFF, 01=TONE, 02=TSQL,
(0000=0 A~ 0121=2 A~ 0241=4 A) 03=DTCS, 06=DTCS (T),
16* (02 00 ~ 02 Send/read the Preamp 07=TONE (T)/DTCS (R),
(00=0FF, 01=P.AMP1, 02=P.AMP2) 08=DTCS (T)/TSQL (R),
(In the 144 or 430 MHz bands, 09=TONE (T)/TSQL (R))
00=0FF, 01=ON) 17*3 See p. 16. Send CW messages
12 01~03 Send/read the AGC time constant 18 00 Turn OFF the transceiver
(01=FAST, 02=MID, 03=SLOW) 01+ T -
urn ON the transceiver




REMOTE CONTROL

Remote control (CI-V) information

¢ Command table

Cmd. | Sub cmd. Data Description Cmd. | Sub cmd. Data Description
19*1 |00 Read the transceiver ID 1A* |05 |SET > Tone Control/TBW
1A* |00 See pp. 17 Send/read memory contents 0020 |Seep.19. TX>SSB >
and 18. Send/read TX bandwidth for mid
01 See p. 18. Send/read band stacking register contents 0021 |Seep. 19. TX > SSB >
02*5 See p. 19. Send/read memory keyer contents Send/read TX bandwidth for narrow
03 Seep.19.  |Send/read the selected IF filter width 0022 |Seep. 19. gx >d /SSBd-?;b i
04 See p. 19. Send/read the selected AGC time endrea ancwl
— Rl N ;x >d;A . g TX Tone (Bass) level
05 [SET > Tone Control/TBW (O%r':_;ef 10=+5‘;"e (Bass) leve
0001 |Seep. 19. RX > SSB >
. 0024 |00~ 10 TX>AM >
Send/read RX HPF/LPF settings Send/read TX Tone (Treble) level
0002 (00~ 10 RX > SSB > (00=—5 ~ 10=+5)
Send/read RX Tone (Bass) level 0025 |00 ~ 10 X > FM >
(00=-5 ~ 10=+5) Send/read TX Tone (Bass) level
0003 (00 ~10 RX > SSB > (00=-5 ~ 10=+5)
Send/read RX Tone (Treble) level 0026 |00 ~ 10 X > EM >
(00=-5 ~ 10=+5) Send/read TX Tone (Treble) level
0004 |Seep. 19. RX>AM > (00=-5 ~ 10=+5)
Send/read RX HPF/LPF settings 0027 |00~ 10 TX > DV >
0005 |00~ 10 RX>AM > Send/read TX Tone (Bass) level
Send/read RX Tone (Bass) level (00=—5 ~ 10=+5)
(00=-5~ 10=+5) 0028 |00 ~ 10 TX>DV >
0006 |00~10 RX>AM > Send/read TX Tone (Treble) level
Send/read RX Tone (Treble) level (00=-5 ~ 10=+5)
(00=-5 ~ 10=+5) SET > Function
0007 |Seep. 19.  |RX>FM > . 0029 |0000 ~ 0255 |Sendiread the Beep Level setting
Send/read RX HPF/LPF settings (0000=Minimum ~ 0255=Maximum)
0008 (00 ~10 RX >FM > -
Sendiread RX Tone (Bass) level 0030 |00/01 f:trt:(ri]/gread the Beep Level Limit
(00=-5 ~ 10=+5) (00=OFF, 01=ON)
0009 |00~ 10 RX > FM > -
Send/read RX Tone (Treble) level 0031 |00/01 S:t?i(:gead the Beep (Confirmation)
(00=-5 ~ 10=+5) (00=OFF, 01=ON)
0010 |Seep. 19. RX > DV >
Sendiread RX HPF/LPF settings 0032 00/01 f:t?iig ead the Home CH Beep
0011 |00~ 10 RX>DV > (00=0FF, 01=0ON)
Send/read RX Tone (Bass) level 0033 |00~ 03 Sendlread the Band Edge Beep
(00=-5 ~ 10=+5) setting
0012 {00~ 10 RX>DV > (00=0OFF, 01=ON (Default),
Send/read RX Tone (Treble) level 02=ON (User),
(00=-5 ~ 10=+5) 03=ON (User) & TX Limit)
0013 {00~10 RX>WFM > 0034 (00 ~ 04 Send/read the Auto Power OFF
Send/read RX Tone (Bass) level setting
(00=—5 ~ 10=+5) (00=OFF, 01=30 min, 02=60 min,
0014 |00~ 10 RX >WFM > 03=90 min, 04=120 min)
Send/read RX Tone (Treble) level 0035 |00 ~03 Send/read the Power Save setting
(00=-5 ~ 10=+5) (00=OFF, 01=Auto (Short),
0015 |Seep. 19. RX > CW > 02=Auto (Middle), 03=Auto (Long))
Send/read RX HPF/LPF settings 0036 |00 ~ 03 Send/read the Max TX Power
0016 |Seep. 19. RX > RTTY > (Battery Pack) setting
Send/read RX HPF/LPF settings (00=0.5W, 01=1 W, 02=2.5 W,
0017 |00~ 10 TX > SSB > 03=5 W)
Send/read TX Tone (Bass) level 0037 (00 ~ 04 Send/read the Max TX Power (DC
(00=—=5 ~ 10=+5) 13.8V) setting
0018 |00~ 10 TX > SSB > (00i0.5 W, 0_1:1 W, 02=2.5 W,
Send/read TX Tone (Treble) level 03=5 W, 04=10 W)
(00==5 ~ 10=+5) 0038 |00 ~ 05 Send/read the TX Delay (HF) setting
0019 |Seep.19. |TX>SSB> (00=OFF, 01=10 ms, 02=15 ms,
Send/read TX bandwidth for wide 03=20 ms, 04=25 ms, 05=30 ms)
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Remote control (CI-V) information

¢ Command table

Cmd. | Sub cmd. | Data Description Cmd. | Sub cmd. Data Description
1A* |05 |SET > Function 1A* |05 |SET > Function
0039 (00 ~ 05 Send/read the TX Delay (50 MHz) 0057 |00/01 SPEECH >
setting Send/read the RX>CS SPEECH setting
(00=0FF, 01=10 ms, 02=15 ms, (00=0FF, 01=0ON)
03=20 ms, 04=25 ms, 05=30 ms) 0058 |00/01 SPEECH >
0041 |00 ~ 05 Send/read the TX Delay (144 MHz) Send/read the MIC Up/Down
setting SPEECH setting
(00=0FF, 01=10 ms, 02=15 ms, (00=0FF, 01=0ON)
03=20 ms, 04=25 ms, 05=30 ms) 0059 |00/01 SPEECH >
0042 |00 ~05 Send/read the TX Delay (430 MHz) Send/read the S-Level SPEECH setting
setting (00=0OFF, 01=0ON)
(00=OFF, 01=10 ms, 02=15 ms, 0060 |00/01 SPEECH >
03=20 ms, 04=25 ms, 05=30 ms) Send/read the MODE SPEECH setting
0043 (00 ~ 05 Send/read the Time-Out Timer (00=OFF, 01=0ON)
setting _ _ 0061 |0000 ~ 0255 |SPEECH >
(00=OFF, 01=3 min, 02=5 min, Send/read the SPEECH Level setting
03=10 min, 04=20 min, 05=30 min) (0000:0% ~ 0255:100%)
0044 |00/01 Send/read the PTT Lock setting 0062 |00/01 Send/read the [SPEECH/LOCK]
(00=0OFF, 01=0N) Switch setting
0045 [00/01 SPLIT > (00=SPEECH/LOCK,
Send/read the Quick SPLIT setting 01=LOCK/SPEECH)
(00=0OFF, 01=ON) 0063 |00/01 Send/read the Lock Function setting
0046 |See p.19. SPLIT > (00=MAIN DIAL, 01=PANEL)
Send/read the SPLIT Offset setting 0064 |00/01 Send/read the Memo Pad Quantity
0047 |00/01 SPLIT > setting
Send/read the SPLIT LOCK setting (00=5 ch, 01=10 ch)
(00=OFF, 01=ON) 0065 |00 ~ 02 Send/read the MAIN DIAL Auto TS
0048 |00/01 Send/read the Tuner (PTT Start) setting setting
(00=0OFF, 01=0ON) (00=0OFF, 01=Low, 02=High)
0049 |00 ~ 02 Send/read the Auto Repeater setting 0066 |00/01 Send/read the MIC Up/Down Speed
(00=0OFF, 01=ON (DUP), setting
02=0ON (DUP,TONE)) (00=Slow, 01=Fast)
0050 |00 ~ 02 Send/read the RTTY Mark 0067 |00 ~ 02 Send/read the [NOTCH] Switch
Frequency setting (SSB) setting
(00=1275 Hz, 01=1615 Hz, (00=Auto, 01=Manual, 02=Auto/Manual)
02=2125 Hz) 0068 |00 ~ 02 Send/read the [NOTCH] Switch
0051 (00 ~ 02 Send/read the RTTY Shift Width (AM) setting
setting (00=Auto, 01=Manual, 02=Auto/Manual)
(00=170 Hz, 01=200 Hz, 02=425 Hz) 0069 |00/01 Send/read the SSB/CW
0052 |00/01 Send/read the RTTY Keying Polarity Synchronous Tuning setting
setting (00=0OFF, 01=0ON)
(00=Normal, 01=Reverse) 0070 {00/01 Send/read the CW Normal Side setting
0053 [00/01 SPEECH > (00=LSB, 01=USB)
Send/read the SPEECH Language 0071 |00/01 Send/read the Charging (Power ON)
setting setting
(00=Japanese, 01=English) (00=OFF, 01=0N)
0054 1 00/01 SPEECH > 0072 |00/01 Send/read the USB Power Input
Send/read the Alphabet setting (Phone, Tablet, PC) setting
(00=Normal, 01=Phonetic Code) (00=OFF, 01=0N)
0055 |00/01 SPEECH > 0073 |00/01 Send/read the Power OFF Setting
Send/read the SPEECH Speed setting (for Remote Control) setting
(00=Slow, 01=Fast) (00=Shutdown only,
0056 (00 ~ 02 SPEECH > 01=Standby/Shutdown)
Send/read the RX Call Sign SET > Function > Remote MIC Key
SPEECH setting :
(00=OFF, 01=ON (Kerchunk), 0074 |See p. 20. Send/read the [A] setting
02=0N (All)) 0075 |See p. 20. Send/read the [B] setting
0076 |See p. 20. Send/read the [A] setting
0077 |See p. 20. Send/read the [V] setting
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Remote control (CI-V) information

¢ Command table

Cmd. | Sub cmd. | Data | Description Cmd. | Sub cmd. Data Description
1A* |05 |SET > Function > Remote MIC Key 1A* |05 |SET > DV Set
0078 |00/01 Send/read the Mode Select (SSB) 0097 |00/01 Send/read the Digital Repeater Set
setting setting
(00=0FF, 01=0ON) (00=0FF, 01=0ON)
0079 |00/01 Send/read the Mode Select (CW) 0098 |00/01 Send/read the DV Auto Detect setting
setting (00=0FF, 01=0ON)
(00=0FF, 01=0N) 0099 |00/01 Send/read the RX Record (RPT) setting
0080 |00/01 Send/read the Mode Select (RTTY) (00=ALL, 01=Latest Only)
setting 0100 |00/01 Send/read the BK setting
(00=0FF, 01=0ON) (00=0FF, 01=0ON)
0081 |00/01 Send/read the Mode Select (AM) 0101 |00/01 Send/read the EMR setting
Sg(t)ﬁrgFF 01=ON) (O0=OFF, 01=0N)
s ~ ing
( 0102 [0000 ~ 0255 |Send/read the EMR AF Level settin
0082 |00/01 Send/read the Mode Select (FM) (0000=0% ~ 0255=100%)
setting
(00=OFF, 01=ON) SET > QSO/RX Log .
0083 |00/01 Send/read the Mode Select (DV) 0103 100/01 Send/read the QSO Log setting
setting (00=0OFF, 01=0ON)
(00=OFF, 01=0N) 0104 |00/01 Send/read the RX History Log setting
0084 |00/01 Send/read the Mode Select (WFM) (00=OFF, 01=ON)
setting 0105 (00 ~ 02 CSV Format >
(00=OFF, 01=0ON) Send/read the Separator/Decimal setting
SET > Function (00=Separator is “, ” and Decimal is “ . ,”
- 01=Separator is “; " and Decimal is “. )"
0085 |00/01 S()%rld_ll_reai theofci)'/:bclala';d Tt))/pe Zettmg 02=Separator is * ;" and Decimal is *, ")
(00=Ten-key, 01=Full Keyboard) 0106 |00 ~ 02 CSV Format >
0086 (00 ~ 02 Send/read the Full Keyboard Layout Send/read the Date setting
setting (00="yyyy/mm/dd,” 01="mm/dd/yyyy,’
(00=English, 01=German, 02="dd/mmlyyyy”)
0087 [00/01 802=d':/ren:hi1 S C SET> Connectors
end/read the Screen Capture 0107 |00~ 02 Send/read the SP Jack Function setting
[POWER] Switch setting
(00=OFF, 01=ON) (00=Speaker, 01=Phone,
0088 [00/01 Send/ ‘ S C i g2=Phone (L+R))
endfread the Screen Capture File 0108 |00 ~ 30 Send/read the Phones Level setting
Type setting (00=—15 ~ 30=+15)
(00=PNG, 01=BMP)
0089 |0000 ~ 0255 |Send/read the REF Adjust setting 0109 100/01 USB AF/IF Output > .
(0000=0% ~ 0255=100%) Send/read the Output Select setting
e (00=AF, 01=IF)
>
hd 0110 ({0000 ~ 0255 [USB AF/IF Output >
0090 (00~ 03 Send/read the Standby Beep setting Send/read the AF Output Level
(00=0FF, 01=0N, setting
02=ON (to me:High Tone), (0000=0% ~ 0255=100%)
03=ON (to me:Alarm/High Tone)) 0111 |oosot USB AF/IF Output >
0091 ({00~ 03 Send/read the Auto Reply setting Send/read the AF SQL setting
(00=OFF.,.01=ON, 02=Voice, (00=OFF (Open), 01=0N)
03=Position) 0112 |00/01 USB AF/IF Output >
0092 |00/01 Send/read the DV Data TX setting Send/read the AF Beep/Speech...
(00=PTT, 01 =AUt0) Output setting
0093 [00/01 DV Fast Data > (00=0FF, 01=0ON)
Send/read the Fast Data setting 0113 |0000 ~ 0255 |USB AF/IF Output >
(00=0OFF, 01=0N) Send/read the IF Output Level
0094 |00/01 DV Fast Data > setting
Send/read the GPS Data Speed setting (0000=0% ~ 0255=100%)
(00=Slow, O1=Fast) 0114 |00/01 WLAN AF/IF Output >
0095 (00~ 10 DV Fast Data > Send/read the Output Select setting
Send/read the TX Delay (PTT) setting (00=AF, 01=IF)
(00=OFF, 01=1sec ~ 10=10sec) 0115 |00/01 WLAN AF/IF Output >
0096 |00 ~ 02 Send/read the Digital Monitor setting Send/read the AF SQL setting
(00=Auto, 01=Digital, 02=Analog) (00=OFF (Open), 01=0ON)
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Cmd. | Sub cmd. | Data Description Cmd. | Sub cmd. Data Description
1A* |05 |SET > Connectors 1A* |05 |SET > Connectors
0116 | 0000 ~ 0255 [MOD Input > 0129 |00/01 External Keypad >
Send/read the USB MOD Level setting Send/read the KEYER setting
(0000=0% ~ 0255=100%) (00=0OFF, 01=0ON)
0117 |0000 ~ 0255 |MOD Input > 0130 |00/01 External Keypad >
Send/read the WLAN MOD Level setting Send/read the RTTY setting
(0000=0% ~ 0255=100%) (00=0FF, 01=0ON)
0118 (00 ~ 03 MOD Input > 0131 |00/01 Cl-V >
Send/read the DATA OFF MOD setting Send/read the CI-V Transceive
(00=MIC, 01=USB, setting
02=MIC, USB, 03=WLAN) (00=OFF, 01=0ON)
0119 (00 ~ 03 MOD Input > 0132 {00/01 Cl-V >
Send/read the DATA MOD setting Send/read the CI-V USB Echo Back
(00=MIC, 01=USB, setting
02=MIC, USB, 03=WLAN) (00=0OFF, 01=0ON)
0120 (00/01 SEND Output > 0133 (00 ~ 03 USB (B) Function >
Send/read the HF setting Send/read the USB (B) Function
(00=OFF, 01=0ON) setting
0121 |00/01 SEND Output > (00=OFF, 01=RTTY Decode,
Send/read the 50M setting 02=DV Data, 03=Weather)
(00=0FF, 01=0ON) 0134 {00/01 USB (B) Function >
0123 |00/01 SEND Output > Send/read the GPS Out setting
Send/read the 144M setting (00=0FF, 01=0N)
(00=OFF, 01=0N) @ltis vz.alid"v.vhen “U?B (B,), .
0124 |00/01 SEND Output > EL;?: tion" s set to "OFF" or "DV
Send/read the 430M setting :
(00=OFF, 01=0ON) 0135 |00/01 Seqd/read the MIC Jack 8V Output
0125 |00~ 04 USB SEND/Keying > ?géirgFF 01=0N)
Send/read the USB SEND setting . :
(00=OFF, 01=USB (A) DTR, SET > Display
02=USB (A) RTS, 03=USB (B) DTR, 0136 |0000 ~ 0255 |Send/read the LCD Backlight setting
04=USB (B) RTS) (0000=0% ~ 0255=100%)
® You cannot select the terminal 0137 |00/01 Send/read the LCD Backlight Auto
which is already selected in the Adjust setting
“USB Keying (CW)” or “USB (00=OFF, 01=ON)
Keyi RTTY)” item.
eying (RTTY)" item 0138 |00 ~ 06 Send/read the Screen Saver
0126 (00 ~ 04 USB SEND/Keying > . (Battery Pack) setting
Seqd/read the USB Keymg (CW) (00=OFF, 01=1min, 02=2min,
setting 03=5min, 04=15min, 05=30min,
02=USB (A) RTS, 03=USB (B) DTR
04=USB EB; RTS’) ® ’ 0139 |00~ 06 Send/read the Screen Saver (DC
® You cannot select the terminal 13.8 V) setting . .
L . (00=0OFF, 01=1min, 02=2min,
which is already selected in the 03=5min. 04=15min. 05=30mi
“USB SEND” or “USB Keying 06:63“”" =tomin, Bo=stmin,
(RTTYY item. =60min)
0127 |00 ~ 04 USB SEND/Keying > 0140 100/01 SF,GC’)‘S\//rEest‘h‘?tS:reet? OFF
Send/read the USB Keying (RTTY) [ 1 Switch setting
setting (00=OFF, 01=0ON)
(00=OFF, 01=USB (A) DTR, 0141 |00/01 Send/read the RX LED setting
02=USB (A) RTS, 03=USB (B) DTR, (00=OFF, 01=ON)
04=USB (B) RTS) 0142 |00/01 Send/read the Meter Peak Hold setting
® You cannot select the terminal (00=0OFF, 01=0N)
which is alre”ady selected |.n the 0143 |00/01 Send/read the Memory Name setting
“USB SEND” or “USB Keying (00=OFF, 01=ON)
(CWY item. :
0144 |00/01 Send/read the Group Name Popup
0128 |00/01 External Keypad > setting
Send/read the VOICE setting (00=OFF, 01=ON)
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1A* |05 |SET > Display 1A* |05 |SET > Time Set

0145 |00 ~ 03 Send/read the RX Call Sign Display 0165 |20000101 ~ |[Date/Time >
setting 20991231 Send/read the Date setting
(00=0FF, 01=Normal, (20000101=2000/1/1 ~
02=RX Hold, 03=Hold) 20991231=2099/12/31)

0146 |00/01 Send/read the RX Position Indicator 0166 |0000 ~ 2359 |Date/Time >
setting Send/read the Time setting
(00=0FF, 01=0ON) (0000=00:00 ~ 2359=23:59)

0147 |00/01 Send/read the RX Position Display 0167 |00/01 Date/Time >
setting Send/read the NTP Function setting
(00=0FF, 01=0ON) (00=0FF, 01=0ON)

0148 |00 ~ 04 Send/read the RX Position Display 0168 |See p. 18. Date/Time >
Timer setting Send/read the NTP Server Address
(00=5sec, 01=10sec, 02=15sec, setting
03=30sec, 04=Hold) (Up to 64 characters)

0149 |00/01 Send/read the Reply Position 0169 |00/01 Date/Time >
Display setting Send/read the GPS Time Correct
(00=OFF, 01=0ON) setting

0150 |00/01 Send/read the RX Picture Indicator (00=0FF, 01=Auto)
setting 0170 |See p. 20. Send/read the UTC Offset setting
(00=0FF, 01=0ON) SET > SD Card

0151 |00/01 Send/read the DV RX Backlight setting 0171 |00 ~ 02 ImporUExport > CSV Format >
(00=0OFF, 01=ON) Send/read the Separator/Decimal

0152 (00 ~ 02 Send/read the TX Call Sign Display setting
setting (00=Separator is “, ” and Decimal is “ . ,”
(00=0OFF, 01=Your Call Sign, 01=Separator is “; " and Decimal is “. "
02=My Call Sign) 02=Separator is “; " and Decimal is “, ")

0153 |00/01 Send/read the Scroll Speed setting 0172 |00 ~ 02 Import/Export > CSV Format >
(00=Slow, 01=Fast) Send/read the Date setting

0154 |00/01 Send/read the Opening Message setting (00=:yyyy/ mm/ dd:’" 01="mm/dd/yyyy,"
(00=0FF, 01=0ON) 02="dd/mml/yyyy”)

0155 |00/01 Send/read the Power ON Check setting SCOPE > SCOPE SET
(00=0OFF, 01=0ON) 0173 {00/01 Send/read the Scope during Tx

0156 |00/01 Display Unit > (CENTER Type) setting
Send/read the Latitude/Longitude (00=OFF, 01=0ON)
setting 0174 |00 ~ 02 Send/read the Max Hold setting
(00=ddd’mm.mm’, (00=0FF, 01=10s Hold, 02=ON)
01=ddd’mm’ss") 0175 |00 ~ 02 Send/read the CENTER Type

0157 {00/01 Display Unit > Display setting
Send/read the Altitude/Distance setting (00=Filter Center,
(00=m, 01=ft/mi) 01=Carrier Point Center,

0158 |00~ 02 Display Unit > 02=Carrier Point Center (Abs. Freq.))
Send/read the Speed setting 0176 |00/01 Send/read the Marker Position (FIX
(00=km/h, 01=mph, 02=knots) Type) setting

0159 |00/01 Display Unit > (00=Filter Center, 01=Carrier Point)
Send/read the Temperature setting 0177 |00/01 Send/read the VBW setting
(00="C, 01=°F) (00=Narrow, 01=Wide)

0160 (00 ~ 03 Display Unit > 0178 (00 ~ 03 Send/read the Averaging setting
Send/read the Barometric setting (00=0OFF, 01=2, 02=3, 03=4)
(00=hPa, 01=mb, 02=mmHg, 03=inHg) 0179 [00/01 Send/read the Waveform Type setting

0161 {00/01 Display Unit > (00=Fill, 01=Fill+Line)
Send/read the Rainfall setting 0180 |Seep.20. |Send/read the Waveform Color
(00=mm, 01=inch) (Current) setting

0162 100 ~ 03 Display Unit > ) 0181 [Seep.20. |Send/read the Waveform Color
S()%nd/;ea&thlf \;\rl]lné;Speid Os?)etﬂng (Line) setting
(00=m’s, 01= m  SCZMPn, 297 no.ts) 0182 |See p.20. |Send/read the Waveform Color

0163 |00/01 Soegdllzrea? trr1]e (I)D;spjay Language setting (Max Hold) setting
(00=English, 01=Japanese) 0183 |00/01 Send/read the Waterfall Display setting

0164 |00/01 Send/read the System Language setting (00=OFF, 01=ON)
(00=English, 01=Japanese)
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Cmd. | Sub cmd. | Data | Description Cmd. | Sub cmd. Data Description
1A* |05 |SCOPE > SCOPE SET 1A* |05 |SCOPE > SCOPE SET
0184 |00 ~ 02 Send/read the Waterfall Speed setting 0211 |See p. 20. FIX Edges > 20.00 - 22.00 >
(00=Slow, 01=Mid, 02=Fast) Send/read the No.3 setting
0185 |00 ~ 02 Send/read the Waterfall Size 0212 |See p. 20. FIX Edges > 22.00 - 26.00 >
(Expand Screen) setting Send/read the No.1 setting
(00=Small, 01=Mid, 02=Large) 0213 |Seep.20. |FIX Edges > 22.00 - 26.00 >
0186 (00 ~ 07 Send/read the Waterfall Peak Color Send/read the No.2 setting
Level setting . 0214 |Seep.20. |FIX Edges > 22.00 - 26.00 >
(00=Grid1 ~ 07=Grid8) Send/read the No.3 setting
0187 |00/01 Send/read the Waterfall Marker 0215 |[See p. 20. FIX Edges > 26.00 - 30.00 >
A(‘)‘gog::d'f g?ttiggN Send/read the No.1 setting
(00=OFF, 01=ON) 0216 |See p.20. |FIX Edges > 26.00 - 30.00 >
0188 |Seep.20. |FIX Edges > 0.03 - 1.60 > Sendiread the No.2 setting
Send/read the No.1 setting 0217 |Seep.20. |FIX Edges > 26.00 - 30.00 >
0189 |Seep.20. |FIX Edges > 0.03 - 1.60 > Sendiread the No_3 setting
Send/read the No.2 setting 0218 |Seep.20. |FIX Edges > 30.00 - 45.00 >
0190 |Seep.20. |FIX Edges > 0.03 - 1.60 > Send/read the No.1 setting
Send/read the No.3 setting 0219 |Seep.20. |FIX Edges > 30.00 - 45.00 >
0191 |See p. 20. FIX Edges >1.60-2.00 > Send/read the No.2 Setting
Send/read the No.1 setting 0220 |Seep.20. |FIX Edges > 30.00 - 45.00 >
0192 |See p. 20. FIX Edges > 1.60 - 2.00 > Send/read the No.3 setting
Send/read the No.2 setting 0221 |Seep.20. |FIX Edges > 45.00 - 60.00 >
0193 |Seep. 20.  |FIX Edges > 1.60 - 2.00 > Send/read the No.1 setting
Send/read the No.3 setting 0222 |Seep.20. |FIX Edges > 45.00 - 60.00 >
0194 |Seep. 20. |FIX Edges > 2.00 - 6.00 > Send/read the No.2 setting
Send/read the No.1 setting 0223 |Seep.20. |FIX Edges > 45.00 - 60.00 >
0195 |See p. 20.  |FIX Edges > 2.00 - 6.00 > Send/read the No.3 setting
Send/read the No.2 setting 0224 |Seep.20. |FIX Edges > 60.00 - 74.80 >
0196 |See p. 20. |FIX Edges > 2.00 - 6.00 > Send/read the No.1 setting
Send/read the No.3 setting 0225 |See p.20. |FIX Edges > 60.00 - 74.80 >
0197 |See p. 20. FIX Edges > 6.00 - 8.00 > Send/read the No.2 setting
Send/read the No.1 setting 0226 |Seep.20. |FIX Edges > 60.00 - 74.80 >
0198 |See p. 20. FIX Edges > 6.00 - 8.00 > Send/read the No.3 setting
Send/read the No.2 setting 0227 |Seep.20. |FIX Edges > 74.80 - 108.00 >
0199 |See p. 20. FIX Edges > 6.00 - 8.00 > Send/read the No.1 setting
Send/read the No.3 setting 0228 |Seep.20. |FIX Edges > 74.80 - 108.00 >
0200 |See p. 20. FIX Edges > 8.00 - 11.00 > Send/read the No.2 setting
Send/read the No.1 setting 0229 |Seep.20. |FIX Edges > 74.80 - 108.00 >
0201 |See p. 20. FIX Edges > 8.00 - 11.00 > Send/read the No.3 setting
Send/read the No.2 setting 0230 |Seep.20. |FIX Edges > 108.00 - 137.00 >
0202 |See p. 20. FIX Edges > 8.00 - 11.00 > Send/read the No.1 setting
Send/read the No.3 setting 0231 |Seep.20. |FIX Edges > 108.00 - 137.00 >
0203 |See p. 20. FIX Edges > 11.00 - 15.00 > Send/read the No.2 setting
Send/read the No.1 setting 0232 |Seep.20. |FIX Edges > 108.00 - 137.00 >
0204 |See p. 20. FIX Edges > 11.00 - 15.00 > Send/read the No.3 setting
he No.2 setti
Send/read the No.2 setting 0233 |Seep.20. |FIX Edges > 137.00 - 200.00 >
0205 |See p. 20. FIX Edges >11.00 - 15.00 > Send/read the No.1 setting
he No.3 setti
Send/read the No.3 setting 0234 |Seep.20. |FIX Edges > 137.00 - 200.00 >
0206 |See p. 20. FIX Edges > 15.00 - 20.00 > Send/read the No.2 setting
Send/read the No.1 setting 0235 |Seep.20. |FIX Edges > 137.00 - 200.00 >
0207 |See p. 20. FIX Edges > 15.00 - 20.00 > Send/read the No.3 setting
Send/read the No.2 setting 0236 |Seep.20. |FIX Edges > 400.00 - 470.00 >
0208 |See p. 20. FIX Edges > 15.00 - 20.00 > Send/read the No.1 setting
Send/read the No.3 setting 0237 |Seep.20. |FIX Edges > 400.00 - 470.00 >
0209 |See p. 20. FIX Edges > 20.00 - 22.00 > Send/read the No.2 setting
Send/read the No.1 setting 0238 |Seep.20. |FIX Edges > 400.00 - 470.00 >
0210 |See p. 20. FIX Edges > 20.00 - 22.00 > Send/read the No.3 setting
Send/read the No.2 setting
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Cmd. | Sub cmd. | Data | Description Cmd. | Sub cmd. Data Description
1A* |05 |AUDIO > AUDIO SCOPE SET 1A* |05 |DECODE > RTTY DECODE SET
0239 |00/01 Send/read the FFT Scope 0260 |00/01 Send/read the Decode New Line
Waveform Type setting Code setting
(00=Line, 01=Fill) (00=CR,LF,CR+LF, 01=CR+LF)
0240 |See p. 20. Send/read the FFT Scope 0261 |00/01 Send/read the TX USOS setting
Waveform Color setting (00=0OFF, 01=0ON)
0241 {00/01 Send/read the FFT Scope Waterfall 0262 |See p. 20. Send/read the Font Color (Receive)
Display setting setting
(00=OFF, 01=0N) 0263 |[See p. 20. Send/read the Font Color (Transmit)
0242 |See p. 20. Send/read the Oscilloscope setting
Waveform Color setting DECODE > RTTY DECODE LOG
VOICE 0264 |00/01 Send/read the Decode Log setting
0243 |0000 ~ 0255 |Send/read the TX LEVEL setting (00=0OFF, 01=0ON)
(0000=0% ~ 0255=100%) 0265 [00/01 Log Set >
0244 (00/01 VOICE TX SET > Send/read the File Type setting
Send/read the Auto Monitor setting (00=Text, 01=HTML)
(00=OFF, 01=0N) 0266 |00/01 Log Set >
0245 |01 ~15 VOICE TX SET > Send/read the Time Stamp setting
Send/read the Repeat Time setting (00=0OFF, 01=0N)
(01=1sec ~ 15=15sec) 0267 |00/01 Log Set >
KEYER > KEYER 001 Send/read the Time Stamp (Time) setting
0246 |00 ~ 04 Send/read the Number Style setting (00=Local, 01=UTC)
(00=Normal, 01=190—ANO, 0268 [00/01 Log Set >
02=190—ANT, 03=90—NO, Send/read the Time Stamp
04=90—NT) (Frequency) setting
0247 (01 ~08 Send/read the Count Up Trigger setting (00=0FF, 01=0N)
(01=M1 ~ 08=M8) RECORD > Recorder Set
0248 |0001 ~9999 |Send/read Present Number setting 0269 |00/01 Send/read the TX REC Audio setting
(0001=1 ~ 9999=9999) (00=Direct, 01= Monitor)
KEYER > CW-KEY SET 0270 |00/01 Send/read the RX REC Condition
0249 [0000 ~ 0255 |Send/read Side Tone Level setting setting
(OOOO=0% ~ 0255=1 00%) (00=Always, 01 =Squelch AUtO)
0250 |00/01 Send/read Side Tone Level Limit setting 0271 100/01 Send/read the File Split setting
(00=OFF, 01=0ON) (00=0OFF, 01=0ON)
0251 |01 ~60 Send/read Keyer Repeat Time setting 0272 |00/01 Send/read the PTT Auto REC Setting
(01=1sec ~ 60=60sec) (00=0FF, 01=0ON)
0252 |28 ~ 45 Send/read Dot/Dash Ratio setting 0273 100 ~03 Send/read the PRE-REC for PTT
(28=1:1:2.8 ~ 45=1:1:4.5 Auto REC setting
in 0.1 steps) (00=0OFF, 01=5sec,
0253 |00~ 03 Send/read Rise Time setting 02=10sec, 03=15sec)
(00=2ms, 01=4ms, RECORD > Player Set
02=6ms, 03=8ms) 0274 (00 ~ 03 Send/read the Skip Time setting
0254 |00/01 Send/read Paddle Polarity setting (00=3sec, 01=5sec,
(00=Normal, 01=Reverse) 02=10sec, 03=30sec)
0255 |00 ~ 02 Send/read Key Type setting SCAN > SCAN SET
(00=Straight, 01=Bug, 02=Paddle) 0275 |00/01 Send/read the SCAN Speed setting
0256 |00 ~ 02 Send/read MIC Up/Down Keyer setting (00=Slow, 01=Fast)
(00=0OFF, 01=ON (UP/DOWN), 0276 |00/01 Send/read the SCAN Resume setting
02=0ON (A/B)) (00=0FF, 01=0ON)
DECODE > RTTY DECODE SET 0277 (00~ 10 Send/read the Pause Timer setting
0257 |00 ~ 03 Send/read the FFT Scope Averaging (00=2sec ~ 09=20sec in 2 seconds,
setting 10=HOLD)
(00=0OFF, 01=2, 02=3, 03=4) 0278 |00 ~ 06 Send/read the Resume Timer setting
0258 |Seep.20. |Sendfread the FFT Scope (00=0sec ~ 05=5sec, 06=HOLD)
Waveform Color setting 0279 (00 ~ 04 Send/read the Temporary Skip
0259 |00/01 Send/read the Decode USOS setting Timer setting

(00=5min, 01=10min, 02=15min,
03=While Scanning,
04=While Powered ON)
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Cmd. | Sub cmd. | Data | Description Cmd. | Sub cmd. Data | Description
1A* |05 |SCAN > SCAN SET 1A* |05 |GPS > GPS TX Mode > D-PRS > TX Format > Position
0280 |00/01 Send/read the MAIN DIAL Operation 0301 (00 ~ 02 Send/read the Time Stamp setting
(SCAN) setting (00=0FF, 01=DHM, 02=HMS)
(00=0OFF, 01=Up/Down) 0302 |00/01 Send/read the Altitude setting
GPS (00=0FF, 01=0ON)
0281 |00 ~ 02 GPS Set > 0303 |00 ~ 02 Send/read the Data Extension setting
Send/read the GPS Select setting (00=OFF, 01=Course/Speed,
(00=0OFF, 01=0ON, 02=Manual) 02=Power/Height/Gain/Directivity)
0282 (00/01 GPS Set > GPS Option > 0304 (00~ 09 Send/read the Power setting
Send/read the SBAS setting (00=0W, 01=1W, 02=4W, 03=9W,
(00=0OFF, 01=0ON) 04=16W, 05=25W, 06=36W,
0283 |00/01 GPS Set > GPS Option > 07=49W, 08=64W, 09=81W)
Send/read the GLONASS setting 0305 (00~ 09 Send/read the Height setting
(00=0FF, 01=0ON) (00=3m, 01=6m, 02=12m, 03=24m,
0284 |00 ~ 05 GPS Set > GPS Option > 04=49m, 05=98m, 06=195m,
Send/read the Power Save setting 07=390m, 08=780m, 09=1561m)
(00=0OFF, 01=1min, 02=2min, 0306 |00~ 09 Send/read the Gain setting
03=4min, 04=8min, 05=Auto) (00=0dB ~ 09=9dB)
0285 |00/01 GPS Set > GPS Option > 0307 |00 ~ 08 Send/read the Directivity setting
Send/read the Satellite Information (00=0Omni, 01=45°NE, 02=90°E,
Out setting 03=135°SE, 04=180°S, 05=225°SW,
(00=GPS/QZSS/GLONASS, 06=270°W, 07=315°NW, 08=360°N)
01=GPS Only) GPS > GPS TX Mode > D-PRS > TX Format > Object
0286 |Seep.21. |GPS Set> 0308 |Seep.18. |Send/read the Object Name setting
Send/read the Manual Position setting (Up to 9 characters)
0287 |00 ~ 02 Send/read the GPS TX Mode Setting 0309 |00/01 Send/read the Data Type setting
(00=0OFF, 01=D-PRS, 02=NMEA) (00=Live Object, 01=Kill Object)
GPS > GPS TX Mode > D-PRS 0310 |See pp. 18 |Send/read the Symbol setting
0288 |See p. 18. Send/read the Unproto Address setting and 21. (2 characters)
(Up to 56 characters) 0311 [Seep. 18. Send/read the Comment setting
0289 |00 ~ 03 Send/read the TX Format setting (Up to 43 characters)
(82=E°Sitigg' 3\1=C:Eje°t’ 0312 |See p.21. |Send/read the Position setting
=ltem, 03=Weather) 0313 |00 ~ 02 Send/read the Data Extension setting
GPS > GPS TX Mode > D-PRS > TX Format > Position (00=OFF, 01=Course/Speed,
0290 |00 ~ 03 Send/read the Symbol setting 02=Power/Height/Gain/Directivity)
(00=No.1, 01=No.2, 0314 [000 ~ 360 Send/read the Course setting
02=No.3, 03=No.4) (000=0° ~ 360=360°)
0291 |See pp. 18 Send/read the Symbol No.1 setting 0315 |0000 ~ 1850 |Send/read the Speed setting
and 21. (2 characters) (0000=0km/h ~ 1850=1850km/h)
0292 |See pp. 18 | Send/read the Symbol No.2 setting 0316 |00~ 09 Send/read the Power setting
and 21. (2 characters) (00=0W, 01=1W, 02=4W, 03=9W,
0293 |See pp. 18 Send/read the Symbol No.3 setting 04=16W, 05=25W, 06=36W,
and 21. (2 characters) 07=49W, 08=64W, 09=81W)
0294 |See pp. 18 Send/read the Symbol No.4 setting 0317 |00 ~ 09 Send/read the Height setting
and 21. (2 characters) (00=3m, 01=6m, 02=12m, 03=24m,
0295 |00 ~ 42 Send/read the SSID setting 04=49m, 05=98m, 06=195m,
(00=- - -, 01=(- 0), 07=390m, 08=780m, 09=1561m)
02=-1~16=-15, 0318 |00 ~ 09 Send/read the Gain setting
17=-A~ 42=-2) (00=0dB ~ 09=9dB)
0296 |00 ~ 03 Send/read the Comment setting 0319 |00 ~ 08 Send/read the Directivity setting
(00=No.1, 01=No.2, 02=No.3, 03=No.4) (00=Omni, 01=45°NE, 02=90°E,
0297 |Seep.18. |Sendiread the Comment No.1 setting 03=135°SE, 04=180°S, 05=225SW,
(Up to 43 characters) 06=270°W, 07=315°NW, 08=360°N)
0298 [Seep. 18. Send/read the Comment No.2 setting 0320 |00 ~42 Send/read the SSID setting
(Up to 43 characters) (ggz ‘1' g ?; =(-1%),
0299 |See p. 18. Send/read the Comment No.3 setting _ Y
17=-A~42=-2)
(Up to 43 characters) 0321 |00/01 Send/read the Time St ti
0300 |See p. 18. Send/read the Comment No.4 setting (O%ZDIE; O1e=H|'\r;|1§) amp setling
(Up to 43 characters) :
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Cmd. | Sub cmd. | Data | Description Cmd. | Sub cmd. Data Description
1A* |05 |GPS > GPS TX Mode > D-PRS > TX Format > Item 1A* |05 |GPS > GPS TX Mode > NMEA

0322 |Seep. 18. Send/read the ltem Name setting 0342*6|00/01 GPS Sentence >
(Up to 9 characters) Send/read the GSA setting

0323 |00/01 Send/read the Data Type setting (00=0OFF, 01=ON)
(00=Live ltem, 01=Killed Item) 0343*¢|00/01 GPS Sentence >

0324 |Seepp. 18 |Send/read the Symbol setting Send/read the VTG setting

and 21. (2 characters) (00=0FF, 01=0N)

0325 |See p. 18. Send/read the Comment setting 0344:%100/01 GPS Sentence >
(Up to 43 characters) Send/read the GSV setting

0326 |See p. 21. Send/read the Position setting 0325 |s 18 (Soo=d?FF,dO1h=OGNIJS v -

0327 |00 ~02 Send/read the Data Extension setting ee p. 16 (S: torzg cltwaeracters) essage setting
(00=0OFF, 01=Course/Speed,
02=Power/Height/Gain/Directivity) GPS > GPS Alarm

0328 |000 ~ 360 Send/read the Course setting 0346 |See p. 21. Sen.d/read the Alarm Area (Group)
(000 ~ 360=0° ~ 360°) setting

0329 |0000 ~ 1850 |Send/read the Speed setting 0347 100 ~02 Send/read the Alarm Area (RX/
(0000=0km/h ~ 1850=1850km/h) ’\ggmf_ry_) Sztt'0n19 Estonded

0330 |00~ 09 Sendiread the Power setting (OZ;B'QEE)G » vi=Exiended,
(00=0W, 01=1W, 02=4W, 03=9W,
04=16W, 05=25W, 06=36W, GPS > GPS Logger
07=49W, 08=64W, 09=81W) 0348 |00/01 Send/read the GPS Logger setting

0331 |00 ~ 09 Send/read the Height setting (00=0OFF, 01=ON)
(00=3m, 01=6m, 02=12m, 03=24m, 0349 |00 ~ 06 Send/read the Record Interval setting
04=49m, 05=98m, 06=195m, (00=1sec, 01=5sec, 02=10sec,
07=390m, 08=780m, 09=1561m) 03=30sec, 04=1min, 05=5min,

0332 |00 ~ 09 Send/read the Gain setting 06=10min)
(00=0dB ~ 09=9dB) 0350 |00/01 Record Sentence >

0333 (00~ 08 Send/read the Directivity setting Send/read the RMC setting
(00=0Omni, 01=45°NE, 02=90°E, (00=0OFF, 01=ON)
03=135°SE, 04=180°S, 05=225°SW, 0351 |00/01 Record Sentence >
06=270°W, 07=315°NW, 08=360°N) Send/read the GGA setting

0334 (00 ~42 Send/read the SSID setting (00=0OFF, 01=ON)
(00=---,01=(- 0), 0352 |00/01 Record Sentence >
02=-1~16=-15, Send/read the VTG setting
17= -A~ 42= -7) (00=OFF, 01=ON)

GPS > GPS TX Mode > D-PRS > TX Format > Weather 0353 [00/01 Record Sentence >

0335 [See pp. 18  |Send/read the Symbol setting Send/read the GSA setting

and 21. (2 characters) (00=0OFF, 01=ON)

0336 |00 ~ 42 Send/read the SSID setting GPS
(00=---,01=(- 0), 0354 |00 ~ 06 Send/read the GPS Auto TX setting
02=-1~16=-15, (00=0OFF, 01=30sec, 02=1min,
17=-A~42=-27) 03=3min, 04=5min, 05=10min,

0337 [Seep. 18. Send/read the Comment setting 06=30min)
(Up to 43 characters) DTMF > DTMF SET

0338 (00~ 02 Send/read the Time Stamp setting 0355 (00 ~ 03 Send/read the DTMF Speed setting
(00=0OFF, 01=DHM, 02=HMS) (00=100ms, 01=200ms,

GPS > GPS TX Mode > NMEA 02=300ms, 03=500ms)

0339*¢ | 00/01 GPS Sentence > NB
Send/read the RMC setting 0356 [0000 ~ 0255 [Send/read the NB LEVEL setting
(00=0OFF, 01=0ON) (0000=0% ~ 0255=100%)

0340*¢|00/01 GPS Sentence > 0357 |00 ~ 09 Send/read the NB DEPTH setting
Send/read the GGA setting (00=1 ~ 09=10)
(00=OFF, 01=0ON) 0358 0000 ~ 0255 |Send/read the NB WIDTH setting

0341*¢|00/01 GPS Sentence > (0000=1 ~ 0255=100)
Send/read the GLL setting
(00=OFF, 01=ON)




REMOTE CONTROL

Remote control (CI-V) information

¢ Command table

Cmd. | Sub cmd. | Data Description Cmd. | Sub cmd. Data Description
1A* |05 |VOX 1F* |00 See p. 22. SET > My Station >
0359 |00 ~20 Send/read the VOX DELAY setting Send/read the My Call Sign setting
(00=0.0s ~ 20=2.0s in 0.1s steps) 01 See p. 22. CS >
0360 |00 ~03 Send/read the VOICE DELAY setting Send/read the UR, R1, R2 setting
(00=0FF, 01=SHORT, 02 See p. 22. SET > My Station >
02=MID, 03=LONG) Send/read the TX Message setting
Cch 20 00 |00* |00/01*" Send/read the Auto DV RX Call
0361 |00/01 Send/read the Call Sign Display/ signs output
Name Display setting (00=OFF, 01=0ON)
(00=Call Sign Display, 01 See p. 22. Output DV RX Call signs for
01=Name Display) transceive
GPS Position 02*' |See p. 22. Read Auto DV RX Call signs
0362 |00 ~ 02 Send/read the Compass Direction 01 [00* [00/01*7 Send/read the Auto DV RX message
setting output
(00=Heading Up, 01=North Up, (00=0FF, 01=ON)
02=South Up) 01 See p. 23. Output DV RX message for
06 See p. 21. Send/read the DATA mode setting transceive
07 00/01 Send/read the NTP server access 02*' |See p. 23. Read Auto DV RX message
(00=Terminate, 01=Initiate) 20 |02 [00* |00/01*7 Send/read the Auto DV RX status
08*! 00 ~ 02 Read NTP server access result output
(00=Accessing, or have not (00=0OFF, 01=0ON)
o1 ;ccessedd :ﬂg; Plg"‘_’le:jON' 01 See p. 23. Output DV RX status for transceive
P 5001 = _d :Jhccczev'(:e ~ " _t alet i 02*' |See p. 23. Read Auto DV RX status
(O%a:OFI? o :O':l)'ca or staus 03 |00 [00/01 Sendlread the Auto DV RX
: - GPS/D-PRS data output
0A 00 ~02 fSem:./reac: tthe Share Pictures (00=OFF, 01=ON)
unction status -
(00=OFF, 01=ON, 02=ON (Repeat)) 0100 |See p. 23. ]?uttput DV.RX GPS/D-PRS Position
® While transmitting the picture or transceive
using the DV Fast Data function, 0101 [See p. 24. Output DV RX D-PRS Object status
sends ON even if the status is set for transceive
to OFF. 0102 |See p. 24. Output DV RX D-PRS Item status
0B*! 00/01 Read the type of power supply for transceive
based on the current voltage 0103 [See p. 25. Output DV RX D-PRS Weather
(00=External power supply, status for transceive
01=Battery pack) 0200* |See p. 23.  |Read Auto DV RX GPS/D-PRS
1B* (00 See p. 21. Send/read the Repeater tone frequency Position status
01 See p. 21. Send/read the TSQL tone frequency 0201*"| See p. 24. Read Auto DV RX D-PRS Object
02 See p. 21. Send/read the DTCS code and polarity status
07 Seep.22. |Send/read the CSQL code (DV mode) 0202*' | See p. 24. Read Auto DV RX D-PRS Item
1C 00* 00/01 Send/read the transceiver’s status status
(00=RX, 01=TX) 0203*'| See p. 25. Read Auto DV RX D-PRS Weather
01* 00 ~ 02 Send/read the Antenna tuner's status status
(00=0OFF, 01=0ON, 02=Tune) 04 |00* |00/01 Send/read Auto DV RX GPS/D-PRS
02* 00/01 Send/read the Transmit frequency message output
. (00=0FF, 01=0ON)
monitor (XFC)
(00=OFF, 01=0ON) 01 See p. 25. Output DV RX D-PRS message for
- - transceive
03 See p. 16. Read the transmit frequency ;
1E  |oo* Read number of available TX 02 See p. 25. Rte:tad Auto DV RX D-PRS message
frequency band status
011 See p. 16. Read TX band edge frequencies 21 00 See p. 25. Send/read the RIT freq.uency
02*1 Read number of user-set TX 01 00/01 S()%rldér'(__e;dot:l_eoR’\llT setting
frequency band (00=OFF, 01=ON) _
03* See p. 16. Send/read the user-set TX band 02 00/01 S()%n_%r??dot?fé:\;r X setting
edge frequencies (00=OFF, 01=ON)

14




REMOTE CONTROL

Remote control (CI-V) information

¢ Command table

level setting

15

Cmd. | Sub cmd. Data Description Cmd. | Sub cmd. Data Description
22 00 See p. 25. Set the DV TX data (Up to 30 byte) 27 (1A 0000 ~ 0002 |Send/read the Sweep speed setting
01 |00* |00/01 Set the Auto DV RX data output (0000=FAST, 0001=MID, 0002=SLOW)
(00=0FF, 01=0ON) 1B 00/01 SCOPE > SCOPE SET >
01 |[Seep.25. |Setthe DV RX data for transceive Sgggl/_lr_‘:g _:_f\l(epicop(tet.during Tx
02 00/01 SET > DV Set > §00=OFF 01:0,3)36 "o
Send/read the DV Data TX setting .
(00=PTT, 01=Auto) 1C 00 ~ 02 SCOPE > SCOPE SET >
Send/read the CENTER Th
03* 00/01 SET > DV Set > DV Fast Data > D?S'Lla;ezemnz ype
Send/read the Fast Data setting (O0=Filter Center
(00=OFF, 01=ON) 01=Carrier Point Center,
04* 00/01 SET >DV Set > DV Fast Data > 02=Carrier Point Center (Abs. Freq.))
Soe(;‘_dglead tg;’_‘ipst[’ata Speed setting 1D 0000/ Sendlread the Scope VBW setting
(00=Slow, 01=Fast) 0001 (0000=NAR, 0001=WIDE)
05* 00~10 SET > DV Set > DV Fast Data > .
Send/read the TX Delay (PTT) setting 1E Seep. 27 fsrjgjg:;‘isthe Scope Fixed edge
(00=0OFF, 01=1sec ~ 10=10sec) %8 00 00~ 08 T the Vorce TX M
23 00*! See p. 25. Read the position status ((;gzgrgp 061 =$I1Ci OS:Tz;nory
01* 00/01/03 GPS > GPS Set > . i
Send/read the GPS Select setting *SAstensk) Send/read data
(00=OFF, 01=ON, 03=Manual) , geag °n|'y gata
. *2 Send only data
02 See p. 21. S:nsd ;625353; ol Position setin *3 In the CW mode, if the [PTT] or an external TX switch is ON, or the
u ” ing Break-in function is ON, a message will be transmitted as CW code
24 00 |00* |00/01 Send/read TX output power setting when you send it from your PC.
= , V1= ending the power comman urns e transceiver
(00=0OFF, 01=0ON) *4 Sending th ON d (18 01) turns ON the t i
01 00/01 Set the TX output power for transceive when the transceiver is OFF (Standby/Shutdown).
(00=OFF, 01=0N) *5 To insert a counter, first clear the other channel’s counter.
25* See p. 26. Send/read the selected or *© Set at least 1 GPS sentence to ON. .
unselected VFO frequency Upto4 GPS sgntences qan be set to ON at the same time.
*7 Qutput setting is automatically set to OFF after turning OFF the
26" See p. 26. Send/read the selected or unselected transceiver
VFO’s operating mode and filter '
27 |00 See p. 26. Read the Scope waveform data
(Only when “Scope ON/OFF status”
(Command: 27 10) and “Scope
data output” (Command: 27 11) are
set to “ON,” outputs the waveform
data to the controller.)
10 00/01 Send/read the Scope ON/OFF status
(00=0FF, 01=0ON)
11 00/01 Send/read the Scope wave data output
(00=0FF, 01=0ON)
12 00 Send/read the Main or Sub scope
setting
(00=Main (fixed))
13 00 Send/read the Single/Dual scope setting
(00=Single (fixed))
14 0000/ Send/read the Scope Center mode
0001 or Fixed mode setting
(0000=CENTER mode,
0001=FIX mode)
15 See p. 27. Send/read the Span setting in the
Center mode Scope
16 0001 ~ 0003 |[Send/read the Edge number setting
in the Fixed mode Scope
17 0000/ Send/read the Scope hold function
0001 ON/OFF status
(0000=0OFF, 0001=0ON)
19 See p. 27. Send/read the Scope Reference



REMOTE CONTROL

Remote control (CI-V) information

¢ Command formats

* Operating frequency
Command: 00, 03, 05, 1C 03

@ @ ® @ ®

Ix ix | xix[xix|xix]o:ix|
Lot 11
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o o 1 o 2 ! ¢ o

! o ] o S o © & o

o l o 5 £ - &2 2 T o
¥ s 05 2 B © £ & 3
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I 8N L 5 o X 2 = & o

o T X &5 &5 o o S

~ - @ - - - - -

* Operating mode
Command: 01, 04, 06

[x x| xix]

(DOperating mode (Filter setting
00:LSB 05:FM 01:FIL1
01:USB 06 :WFM 02:FIL2
02:AM 07:CW-R 03:FIL3
03:CW 08:RTTY-R —
04:RTTY 17:DV —

@Filter setting, (@) can be skipped with command
01 and 06. In that case, “FIL1” is selected with
command 01 and the default filter setting of the
operating mode is automatically selected with
command 06.

* Band edge frequency settings
Command: 02*, 1E 01, 1E 03

© 2@ 6 o 6 ® 0 6 © O b @
|x5x|x§x|x§x|x5x|x5x|05x|25D|x5x|x5x|x'x|x'x|0'x|

o T
1 <t O> ﬁ'
® o T @
g ) oo o, o S
© o Oﬁzlc?'mmoeo’mmllllm‘uo
e R Y - -y 1 o _ ol X7
* o ..o o E X% 1 o o o e =
o Clo 2 895 X oloE s o
O O EoEGes2 £ o EoEGE o2
B2 o o2EET T £ o o2EEDT
E o550y § OEDG C5 022y
S F o5 °ON T = S o5 0N T B
€ S5O NT ND I ©® O S NT NN L
S I NT NN S © INT NN
o NONTXT=T 1= g NI NITXT=TT=
o INTcoX¥X2550 2 TRTooX2550
T o SSo oo S 9 o Sdoo S
I mrerrrrrrres N v«
Lower edge Higher edge

* When obtaining the edge number (by command
“02”), the edge number (D) is not returned.

16

* Duplex Offset frequency setting
Command: 0C, 0D

[ x i x| xix]o:x|

o . o £ 45
T 5 2 & £
S 2 B = & g
£ © 5 2 2 %
2 BT 2 T 5
© N

N I N 5 g
N I X I T
I x 2
x 8 8 =

o o o o
~ - - - -

» Codes for CW message contents
Command: 17 (Up to 30 characters)

To send CW messages, use the following
character codes.

Character | ASCIll code | Character | ASCII code
0~9 30~39 ’ 27
A~Z 41 ~ 5A ( 28
a~z 61 ~7A ) 29

2F = 3D
? 3F + 2B
. 2E ? 22
- 2D @ 40
, 2C Space 20
3A

®“FF” stops sending CW messages.
®“" is used to transmit a string of characters with no
inter-character space.



REMOTE CONTROL

Remote control (CI-V) information

<& Command formats

* Memory content
Command: 1A 00

OO\ 3,606 —6~0— @ @ ® ® — ©®~0® —— 1~ —/— D~ —

XXX XXX+ XX XXX XE XXX XE O X XX XX XE XXX XX xg><|xgx|><§x|j

® —®~® — —O~—, —C~M— — B~ —— O~@ —— B~E —

DX XX]XX - X XXX XXX

D

@, @: Memory group number
0000 ~ 0099: Memory channel group
0100: Call channel group

3, @: Memory channel numbers

* When Memory channel group is selected,
0000 ~ 0099: 00 ~ 99

* When Call channel group is selected,
0000, 0001: 144 C1, C2
0002, 0003: 430 C1, C2

(®: Split and Select memory setting
®

\ A

0=OFF*
1= %1
2=%2
3=%3

0=Split OFF, 1=Split ON

* Set 0 for Call channel.

(©~(0: Operating frequency setting
®See “Operating frequency.” (p. 16)

@, (2: Operating mode setting
®See “Operating mode.” (p. 16)

@3): Data mode setting
1 byte data (XX)

00: Data mode OFF
01: Data mode ON

14: Duplex and Tone settings

0=0OFF
1=TONE
2=TSQL
0=Duplex OFF | 3=DTCS
1=Duplex-
2=Duplex+

17

@): Digital squelch setting
@®
T t Fixed
0=Digital squelch function OFF

1=Digital call sign squelch function ON (DSQL)
2=Digital code squelch function ON (CSQL)

(16)~(18: Repeater tone frequency setting

(19~@): Repeater tone frequency setting

® See “Repeater tone/tone squelch frequency setting.”
(p- 21)

@~@: DTCS code setting
®See “DTCS code and polarity setting.” (p. 21)

@: DV Digital code squelch setting
®See “DV Digital code squelch setting.” (p. 22)

26~@9: Duplex offset frequency setting
®See “Duplex Offset frequency setting.” (p. 16)

29~80: UR (Destination) call sign setting
(8 characters, fixed)

@D~@: R1 (Access repeater) call sign setting
(8 characters, fixed)

@~62: R2 (Gateway/Link repeater) call sign setting
(8 characters, fixed)

®See “DV TX call signs setting.” (p. 22)

63~6: Memory name setting (16 characters, fixed)
®See “Codes for character entries.” (p. 18)

To clear the memory channel contents on 1A 00:
@, ®: Memory channel (0001~0099)
@: “FF,” ® ~ : None

NOTE:

« The same data as ® ~ 62 are stored in @ ~ @.

+ When the Split function is ON, the data of @ ~ @
is used for transmit.

» Even if the Split function is OFF, enter the data
into @ ~ @ to match your transceiver. We
recommend that you set the same data as ® ~ ©.



REMOTE CONTROL

Remote control (CI-V) information

<& Command formats

» Codes for character entries * Band stacking register
Command: 1A 00, Command: 1A 01
1A 05 0168, 0288, 0308, 0310, ® ®
0311, 0322, 0325, 0337,
0345,
1A 05 0291 ~ 1A 05 0294,
1A 05 0297 ~ 1A 05 0300

ESESESES

NOTE: When sending the contents, the codes,
such as operating frequency and operating

- Character codes— Letters and Numbers

mode*, should be added after the frequency
band code and the register code, as shown

Character | ASCII code Character | ASCII code below
A~Z 41~ 5A a~z 61~7A * See ©® ~ 62 on “Memory content.” (p. 17)
0~9 30 ~ 39
(: Frequency band codes
Code Freq. band Frequency range (unit: MHz)
- Character codes— Symbols 01 19 1.800000 ~  1.999999
Character | ASCII code Character | ASCII code 02 3.5 3.400000 ~ 4.099999
! 21 # 23 03 7 6.900000 ~  7.499999
$ 24 % 25 04 10 9.900000 ~ 10.499999
& 26 \ 5C 05 14 13.900000 ~ 14.499999
? 3F i 22 06 18 17.900000 ~ 18.499999
’ 27 ’ 60 07 21 20.900000 ~ 21.499999
A SE + 2B 08 24 24.400000 ~ 25.099999
- 2D * 2A 09 28 28.000000 ~ 29.999999
/ 2F : 2E 10 50 50.000000 ~ 54.000000
, 2C : 3A 1 WFM 74.800000 ~ 107.999999
; 3B = 3D 12 Air 108.000000 ~ 136.999999
< 3C > 3E 13 144 144.000000 ~ 148.000000
( 28 ) 29 14 430 420.000000 ~ 450.000000
[ 5B ] 5D 15 GENE Other than above
{ 7B } 7D
7C 5F .
| = (2): Register codes
- 7E @ 40
Code | Registered number
Cmd. | Sub cmd. Set item/selectable characters 01 ! (D!splay ?n left side)
1A oo Memory name 02 2 (Display in center)
All characters are usable. 03 3 (Display on Right side)
05 | 0168 |NTP Server Address
A~Z,a~z0~9,.,-

To read the contents, the register code should be

added after the frequency band code, as shown

below.

Example: When reading the frequency displayed
in the center of the display in the 21
MHz band, use code “0703.”

18
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Remote control (CI-V) information

<& Command formats

* Keyer memory character entries * AGC time constant settings

Command: 1A 02

Command: 1A 04

AGC time constant (sec.)

- Character codes Data
. SSB/CW/RTTY AM
Character | ASCIl code Description 00 OFF OFF
0~9 30 ~39 Numbers 01 01 03
A~Z 41 ~5A Letters 02 0.2 05
Spj\ce ZI(:) Wc;rd str))alce 03 03 08

mbo

? 3F Szmbol o 2.5 12
05 0.8 1.6
2C Symbol 06 1.2 2.0
: 2E Symbol 07 1.6 25
2 ° Exampl tsyrrll’IZ()lB_T o 29 >0
A 5E xample- eonf‘:r N5 09 25 4.0
. oA Inserts the contest number 10 3.0 5.0
(can be used for 1 channel only) 1 4.0 6.0
12 5.0 7.0
®Information 13 6.0 8.0

* “FA” (NG) is returned if you insert the content
number in more than 1 channel.
» Spaces after the end of the sentence are not

* RX HPF/LPF setting for each operating mode

Command: 1A 05 0001, 0004, 0007, 0010,

necessary. 0015, 0016
 To clear the Keyer memory contents, send one or -

more spaces.

* Keyer memory content
Command: 1A 02

@ ~ @: Text data

* IF filter width settings

HPF (Lower edge)J L LPF(Upper edge)
00=Through
01 ~20=100 ~ 2000 Hz

05 ~ 24=500~2400 Hz
25=Through

*The value of the HPF should be smaller than the LPF.

+ SSB/SSB-DATA transmission passband
width settings

Command: 1A 05 0019 ~ 0022

) Lower edge Higher edge

®-0?f=1?/f|11ne' ggt:aMs _T_ 0=100Hz 0= 2500 Hz

0202 0BMB Lower edge 1=200Hz 1=2700 Hz

2=300Hz 2=2800 Hz

03=M3 07=M7 Higher edge 3=500Hz 3=2900 Hz
04=M4 08=M8

* Split offset frequency setting

Command: 1A 05 0046

Command: 1A 03 @ @ ® ®
| x i o | x i x| oix ]| x i x|
Mode Data Steps T A
SSB/CW/RTTY| 0~9 |50~ 500 Hz (50 Hz) T [ o i I T T
SSBICW 10 ~40 | 600 Hz ~ 3.6 kHz (100 Hz) > iy : LT Direction:
o e IE e o o 00=+ direction
RTTY 10~ 31 | 600 ~ 2.7 kHz (100 Hz) S £ T £ 5 £ of=directon
AM 0~49 |200 Hz ~ 10.0 kHz (200 Hz) 2 % ~x T 3 %
N Io T =T I
< S .5_2 I o o .}'_f =

19
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Remote control (CI-V) information

<& Command formats

* UTC Offset setting + Color settings
Command: 1A 05 0170 Command: 1A 05 0180, 0181, 0182, 0240,
| x x| x i x [ x i x| 0242, 0258, 0262, 0263
\ : / I o @ 6 ®e® 6 6
Offset time Shift direction o ix[xix]oix[xix]o x|x x|
0000 ~ 1400 00=+ (plus) \ \ \ /
01=- (minus) R (Red) G (Green) B (Blue)

0000 ~ 0255 0000 ~ 0255 0000 ~ 0255

* Remote MIC Key setting » Bandscope edge frequency settings
Command: 1A 05 0074 ~ 0077 Command: 1A 050188 ~ 1A 05 0238
Data Function @ @ 3 @ ® ® @
00 | No function [xo[x x|x x[o:x[x:io[x:x[x:x[o:X]
o T T
03 UP (VFO: kHz) 25‘35952325'359523
04 DOWN (VFO: kHz) N§§§£§§§N§EEE§§§
05 |VOLUP tgg¥255g%gg22s50g
06 VOL DOWN | I |
07 XFC Lower edge Higher edge
08 CALL
09 VFO/MEMO
10 DR

11 FROM/TO (DR)

12 Home CH

13 BAND/GROUP UP
14 BAND/GROUP DOWN
15 SCAN

16 Temporary Skip

17 SPEECH

18 MODE

19 RF Power

20 Voice TX (T1)

21 Voice TX (T2)

22 Keyer Memory (M1)
23 Keyer Memory (M2)

24 T-CALL*
25 RX>CS
26 TS

27 MPAD
28 SPLIT
29 A/B

* Only for European version.

20



REMOTE CONTROL

Remote control (CI-V) information

<& Command formats

* Manually entered position data » Alarm area (Group) setting
Command: 1A 05 0286, 0312, 0326, Command: 1A 05 0346
2302 ® @ ®
D~® ©-~0 @~® [ xix[xix]|x:o]
X[ o PXXPXEX] e XX [x0X I Pt
> © 1
* * * * Lr) l
D@ 6Ee6 O©®6G® O MO @B B ¢ 2l o <
Dex[xix[xix|x:0]o X o:x|x:x[x:x[x:x|x:0[0ix[xix|xix|xix]0:X] z o = § 2
1 > 2 92 o .
in i © .g) © c £ —
8 3 s 2 £ € E =
S 2 I £ IS S X
£ =) g - = Q =
CDLDO’OFI g‘;mmm?l %l?m o T T e e e e
2919802 | (21021982 | | 8202 Ton
Eggo%gg S gggioggg 1852242 + Data mode with filter width settings
(o k=4 = .9 Q 5 O o D Eol L=
S232°.2| [5|55232°s8| |Sao0252 Command: 1A 06
B e 25 E 08 e85 505,05~
P52 EET oDl 5L 2 EETTEERLS S 2T
DL ESEECE QO _ Q00O ESEESE QOO SER2GET O @ @
S PECE o ESEC S PEEE R Eg8gEuExd
o [oleNe] o . N
oPoES B St dt8oCoE 555588885
Latitude Longitude Altitude

00=Data mode OFF* 01=FIL1

. 01=Data mode ON 02=FIL2
@ ~ ®: Latitude (dd°’mm.mmm format) 03=FIL3

® ~ (D: Longitude (ddd°’mm.mmm format)
@ ~ @9: Altitude (0.1 meter steps)
* When reading the contents with no altitude, sends

*When 00 is set, also set 00 to @.

®, @3, (4, and @ as “FF.” + Repeater tone/tone squelch frequency settings
* When sending the contents with no altitude, set (2, Command: 1B 00. 1B 01
®, @, and ©® to “FF” " @ ®
o o[ x i x [ x x|
BEERE
L L o & T o
« D-PRS Symbol setting S 2 = 2 o =
Command: 1A 05 0291 ~ 1A 05 0294, 5 2 2 2 % 3
1A 05 0310, 0324, 0335 ° ° T N N T
2 2 8 o T -
| x : x | x © x Lok = < < 9

A A *Not necessary when setting a frequency.
First digit Second digit
* DTCS code and polarity setting

*/,\,0t0 9, Ato Z can be used for the first digit Command: 1B 02
character.
» See “Codes for character entries” for the second @ @ ®
digit character. (p. 18) | x x| ' | ' |

0 (fixed) ——— | ©

First digit: 0 ~ 7 —>| X
Third digit: 0 ~ 7 ——| X

Second digit: 0 ~ 7 —>| X

— Receive polarity: 0=Normal
1=Reverse

Transmit polarity: 0=Normal
1=Reverse

21
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Remote control (CI-V) information

<& Command formats

* DV Digital code squelch setting
Command: 1B 07

o
Y
=
-
2

x
o
x

o
©

Second digit: 0 ~ 9 —>

i

* DV MY call sign setting

Command: 1F 00

Set your own call sign and note of up to 12
characters.

See “Character’s code of the call sign.”

_______ @“’@ \
D] XXX XX XXX X

(M ~ ®: Your own call sign setting (8 characters)
(9 ~ (: Note setting (4 characters)

* DV TX call signs setting (24 characters)
Command: 1F 01

Set “UR,” “R1,” and “R2” call signs of 8
characters (fixed).

See “Character’s code of the call sign.”

@ ~ ®: UR (Destination) call sign setting
(8 characters)

(9 ~ (©: R1 (Access/Area repeater) call sign setting
(8 characters)

(D ~ @: R2 (Link/Gateway repeater) call sign setting
(8 characters)

Character’s code of the call sign

Character | ASCII code
0~9 30~ 39
A~Z 41 ~ 5A

(Space) 20
/ 2F

* DV TX message setting

Command: 1F 02

Set the transmit message of up to 20 characters.
See “Codes for character entries.” (p. 18)

“FF” stops sending or reading messages.
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* DV RX call sign data
Command: 20 0001, 0002
@, —3~0 — M~ —0B ~@—

DX e DOXDxpixfxin] - [xix] —~
—®-® D-®
rix] e Pxix|xix] e [xix]

(D: Header flag data (First byte)

Data Description
bit7 | (0: Fixed) —
bité | (0: Fixed) —
bit5 | (0: Fixed) —
bit4 0 0=Voice, 1=Data
bit3 0/1 0=Direct, 1=Through repeater
bit2 01 0=No Break-in, 1=Break-in
bit1 oM 0=Data, 1=Control
bit0 (0741 0=Normal, 1=EMR

(2): Header flag data (Second byte)

Data
Description
bit2 | bit1 | bit0
1 1 1 | Repeater control
1 1 0 |Send auto acknowledge
1 0 1 | (Not used)
1 0 0 | Request to re-transmit
0 1 1 | Send acknowledge
0 1 0 |Receive no reply
0 0 1 | Repeater disabled
0 0 0 |NULL

(® ~ (0: Call sign of the caller station
(8 characters, fixed)

@) ~ (9: Note of the caller station
(4 characters, fixed)

@5 ~ @: Call sign of the called station
(8 characters, fixed)

@) ~ 30: Call sign of the access/area repeater (R1)
(8 characters, fixed)

@) ~ 39 Call sign of the link/gateway repeater (R2)
(8 characters, fixed)

See “Codes for character entries.” (p. 18)

®FF: When no call sign is received since the

transceiver power was turned ON.
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Remote control (CI-V) information

<& Command formats

* DV RX message
Command: 20 0101, 0102

O~ —O~-B—— /B ~@
Dix] e Px(xix] oo ixxex|xix|

(D ~ @): Message (20 characters)

@) ~ @3: Call sign of the caller station (8 characters)

~ 32: Note of the caller station (4 characters)

See “Codes for character entries.” (p. 18)

®FF: When no call sign is received since the
transceiver power was turned ON.

Example: When a Gateway call is received

JM1ZLK calling from
: JPAYIU portA...
[RXRPT1] 7D ﬁ

/14
72
7)75’&3// RXRPT2

CALLED
P 09
\‘M‘ ot A
3“\!; R
YOUR STATION

CALLER: Caller’s call sign
CALLED: Called station call sign
RXRPT1: Call sign of the repeater that was
accessed by the caller station
@If it was a call through a gateway and the
internet, this item displays the gateway
call sign of the repeater you received the
call from.
RXRPT2: Call sign of the repeater you received
the call from

AN
INTERNE"

* DV RX Status setting
Command: 20 0201, 0202

* GPS/D-PRS data
Command: 20 03 0100, 0101, 0102, 0103,
0200, 0201, 0202, 0203

Data number and description

Data number Description
00 D-PRS — Position
01 D-PRS — Object
02 D-PRS — Item
03 D-PRS — Weather
Position
Command: 20 03 0100, 0200
D-9— ©® @, —@-~-B—
loi0[xix| - |x XX x|x: x|x X| e [XiX]
"_Data number 7
B o] o o]
B~ D~B—
] o [x ] - ex X
M ~ (@: Call sign/SSID

(9 ASCII characters (A~Z,0~9, /, -, space))
Symbol (2 ASCII characters (00h ~ EFh))
: Latitude (dd°’mm.mmm format)
: Longitude (ddd°mm.mmm format)
: Altitude (0.1 meter steps)
Course (1 degree steps)
: Speed (0.1 km/h steps)
: Date (UTC: yyyymmddHHMMSS)
(y: Year, m: Month, d: Day,
H: Hour, M: Minute, S: Second)

,-
e

l

8

l

SISISISISISIC)
l l
GICRESLS

Data Function Description ~ @: See the table below.
bit7 | 0 |(Fixed) — Power Height Gain Directivity
While receiving a digital voice Data (W) (mift) (dB) (deg)

bit6 | 0/1 Receiving a signal, select “1.” 0 0 3110 0 Omni-directi

voice call (Regardless of DSQL and mni-direction
CSQL setting) 1 1 6/20 1 45° NE
. Last call When the last call was finished 2 4 12/40 2 90° E

bit5 | 0/1 | P
finisher by you, select “1. 3 9 24/80 3 135° SE

bita | 0/1 Receiving a |When the aud“io fone can be 4 16 49/160 4 180° S
signal heard, select “1. 5 o5 98/320 5 205° SW

bit3 | 0/1 Receiving a While receiving a BK call, S
BK call select “1 " 6 36 195/640 6 270° W

bit2 | 0/1 Receiving a While receiving a EMR call, 7 49 390/1280 7 315° NW
EMR call select “1.” 8 64 780/2560 8 360° N

_ Recelvmg a When “DV” and “FM” are 9 81 1561/5120 9 —

bit1 | 0/1 |signal other - wq » . . . . g

than DV blinking, select “1. @ The item, that is not contained the received data, is filled
— . with “FF.”

bit0 | 0/1 Packet loss }‘Np!le displaying packet loss, @ FF: No signal has been received since the power was

status 17 is returned.

23

turned ON.
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Remote control (CI-V) information

<& Command formats

* GPS/D-PRS data (Continued)

Object
Command: 20 03 0101, 0201

—\.®

oTifxx] -

C|x_x|

@ ~ @: Call sign/SSID
(9 ASClI characters (A~ Z,0~9, /, -, space))

19, @:

@

Symbol (2 ASCII characters (00h ~ EFh))
~ (9): Latitude (dd°mm.mmm format)

@ ~ @: Longitude (ddd°’mm.mmm format)
@ ~ @: Altitude (0.1 meter steps)
@), @: Course (1 degree steps)
~ 3D: Speed (0.1 km/h steps)

Item
Command: 20 03 0102, 0202

.@

o7zfxx] -

H— D ®

"""" XXX

B~ B B @ ®

@ ~ @: Call sign/SSID
(9 ASClI characters (A~ 2,0~ 9, /, -, space))

10, @:

2 ~

|x§x|x§x|x§x|x§x|x§x|j

Symbol (2 ASCII characters (00h ~ EFh))
@®: Latitude (dd°’mm.mmm format)

@) ~ @: Longitude (ddd°’mm.mmm format)
@ ~ @: Altitude (0.1 meter steps)
@), @®: Course (1 degree steps)
~ 3D: Speed (0.1 km/h steps)

32 ~ 39: Date (UTC: yyyymmddHHMMSS) 32 ~ 35: See the table below.
(y:_Year’ m. _Mo_nth’ d: Pay’ 32 Power | 33 Height Gain | 49 Directivity
' H: Hour, M: Minute, S: Second) Data w) (mift) (dB) (deg)
~ @: See the table below. 0 0 3110 0 | Omni-direction
Power Height Gain Directivity 1 1 6/20 1 45° NE
Data (W) (m/ft) (dB) (deg) 2 4 12/40 2 90° E
0 0 3/10 0 Omni-direction 3 9 24/80 3 135° SE
1 1 6/20 1 45° NE 4 16 49/160 4 180° S
2 4 12/40 2 90° E 5 25 98/320 5 225° SW
3 9 24/80 3 135° SE 6 36 195/640 6 270° W
4 16 49/160 4 180° S 7 49 390/1280 7 315° NW
5 25 98/320 5 225° SW 8 64 780/2560 8 360° N
6 36 195/640 6 270° W 9 81 1561/5120 9 —
7 49 390/1280 7 315° NW
8 64 780/2560 8 360° N ~ @: Name
(9 ASCII characters (00h ~ EFh))
9 81 1561/5120 | 9 — @:  Type (1= Live, 0= Killed)
~ 6D: Name
(9 ASCII characters (00h ~ EFh)) ®vTv?t$1 |t|t:e|r;1 that is not contained the received data, is filled
Rz Type (1= Live, 0= Killed) ® FF: No signal has been received since the power was
. . . . e turned ON.
® The item, that is not contained the received data, is filled
with “FF.”

® FF: No signal has been received since the power was

turned ON.

24
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Remote control (CI-V) information

<& Command formats

* GPS/D-PRS data (Continued)

Weather
Command: 20 03 0103, 0203

—D~O— @ @ —@~®—

lo:3[xix] - [xix|xix[xix|[xix] -~ [xix]
~_Data number j
ne B-0— ® & @

xix|

@ ~ @: Call sign/SSID

(9 ASClI characters (A~ Z,0~9, /, -, space))
19, @: Symbol (2 ASCII characters (00h ~ EFh))
@ ~ (®: Latitude (dd°’mm.mmm format)
@ ~ @: Longitude (ddd°’mm.mmm format)
@ ~ @: Date (UTC: yyyymmddHHMMSS)

(y: Year, m: Month, d: Day,

H: Hour, M: Minute, S: Second)

30, @D: Wind direction (1 degree steps)

32, 33: Wind speed (0.1 m/s steps)

@9, 39: Gust speed (0.1 m/s steps)

~ @1): Temperature (0.1°C steps)

@39): Temperature (0= + degree, 1= — degree)
39, @0: Rainfall (0.1 mm steps)

@), @: Rainfall (24 hours) (0.1 mm steps)

@), @: Rainfall (Midnight) (0.1 mm steps)

@, @: Humidity (1% steps)

~ @9: Barometric pressure (0.1 hPa steps)

® The item, that is not contained the received data, is filled
with “FF.”
@ FF: No signal has been received since the power was
turned ON.

* GPS/D-PRS message
Command: 20 0401, 0402
O~O——0~8—
[xix]: - [xix[xix] - - - [xiX]
(Variable length)

@ ~ (@: Call sign/SSID

(9 ASCII characters (A~Z,0~9, /, -, space))
~ 62: Message

(Up to 43 ASCII characters (00h ~ EFh))

@ FF: No signal has been received since the power was
turned ON.
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* RIT frequency settings
Command: 21 00

[ x ¢ x | x i x| x i X
[
(o)}
o o ?
! S l o
° o ° N
T E % g 00: + (plus)
= - - e 01: — (minus)
* DV TX data
Command: 22 00
@®~60

(Variable length)

@ ~ 30: TX data (Up to 30 Byte)

®“FA” to “FF” are entered after converted to “FF 0A”
to “FF OF” automatically. Up to 60 Byte data can be
entered in this case.

* DV RX data (transceive)
Command: 22 0101

@ ~ 60: RX data (Up to 30 Byte)

®“FA” to “FF” are entered after converted to “FF 0A”
to “FF OF” automatically. Up to 60 Byte data can be
entered in this case.

* MY position data
Command: 23 00

XX XX XX e o

@ ~ ®: Latitude (dd°’mm.mmm format)

(® ~ @D: Longitude (ddd°mm.mmm format)

12 ~ (5: Altitude (0.1 meter steps)

@), @): Course (1 degree steps)

~ @): Speed (0.1 km/h steps)

@) ~ @): Date (UTC: yyyymmddHHMMSS)
(y: Year, m: Month, d: Day,
H: Hour, M: Minute, S: Second)
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Remote control (CI-V) information

<& Command formats

+ Selected or unselected VFO frequency settings
Command: 25

[xix]xix]xix] xix [ xix]xi ]

L JL ]

gperating frequency

See “Operating frequency.” (p. 16)

00=Selected VFO
01=Unselected VFO

®When using the DR function, the transceiver returns
“FA” (NG) because these cannot be set to 01.

* When VFO Ais selected
00=frequency of VFO A changes
01=frequency of VFO B changes

* When VFO B is selected
00=frequency of VFO B changes
01=frequency of VFO A changes

* Selected or unselected VFO’s operating
mode and filter settings
Command: 26

Both data and filter settings can be skipped.
In that case, “DATA OFF” and the default filter
setting of the operating mode is automatically
selected.

(@Data mode setting

A A
T (DOperating mode setting (Filter setting
00=Selected VFO
01=Unselected VFO

®When using the DR function, the transceiver returns
“FA” (NG) because these cannot be set to 01.

* When VFO A is selected
00 = operating mode of VFO A changes
01 = operating mode of VFO B changes
* When VFO B is selected
00 = operating mode of VFO B changes
01 = operating mode of VFO A changes

(D Operating mode (2 Data mode @ Filter
setting setting setting
00:LSB 05:FM 00: Data mode OFF | 01:FIL1
01:USB 06:WFM 01: Data mode ON | 02:FIL2
02:AM 07:CW-R — 03:FIL3
03:CW 08:RTTY-R — —
04:RTTY |17:DV — —

26

* Scope waveform data
Command: 27 00

Outputs the waveform data to the controller.

® @ ® ®@ 6 6 @
00| XEX| XEX|XEX|XEX| XX | XX+ |x§x
(D: 00 (Fixed)

(2 Order of division data (Current): 01~11
(® Division number (Maximum): 01(WLAN), 11(USB)
®When data is sent to the controller using
the WLAN function, all data is sent together.
However, when the data is sent through the
[microUSB] port, the data is divided by 11 and
sent in sequential order.
®The 1st data sends only the wave information
(® ~ ®) without the waveform data (D). The
2nd or later data sends the minimum wave
information (D ~ ®) with waveform data ().

@ Center or Fixed mode data:
* 00 = Center mode scope
* 01 = Fixed mode scope

(® Waveform information:

The waveform information is different between

the Center mode and the Fixed mode.

* In the Center mode:
Center frequency and span are sent.
See page 16 for Operating frequency data,
and the Scope span settings to the right.

* In the Fixed mode:
Lower edge and higher edge frequencies are
sent See page 27 for Scope Fixed edge
frequency settings 3 ~ @.

(® Out of range information:
* 00 =In range
* 01 = Out of range
®If the scope data is out of range, the waveform
data () is omitted.

@ Waveform data:
The transceiver outputs the drawn waveform
data. The data range or data length of the
waveform data is judged by the controller.
(The data range is basically the same as the
display size of the scope on the controller.)
» Data range: 0 ~ 160
» Data length: 475
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Remote control (CI-V) information

<& Command formats

» Scope span settings (in the Center mode Scope) » Scope Fixed edge frequency settings
Command: 27 15 Command: 27 1E
®© @ 6 ® 6 ® Span (kHz) o e 6 6 ® ® ® @ O O ®
loiofojo[xix|xix|oio]oi0] 2500 2.5 |x§x|0§x|x'x|x'x|x'x|x§x|o§x|x§x|x§x|x§x|x§x|o§x|
11 T Ti 5000] 5 4 TT TT
P T ool 10000 10 8 B T e
~ it e~ 1 03 o
394 | SN 288E g S o ovczj‘o?o"@iféov A T
X Q0 o oL x X 25000 25 2 Z 7o 590t = 0o g2lo =1
LXoa_ o gtie § b otlooE9iC0oEoc 10080 s00%F
SL 5959 %cox 50000| 50 S S Lo EDE5eES 0 E0EGEE 0
S CEoeE L o g E 525202500 oL 5202020 5
L 1Es 52525252 100000| 100 s EEQEEENgEﬁgﬁg’EEENEEEE
T30 L20 g aNTTT T QINTSZESIIZSINTISSESIT
SENTNTEEI NS 250000 | 250 g 85T¥885520851%8855298
CEEST 885050208 500000 | 500
A Lower edge Higher edge
®Entry of 100 Hz less than digits are ignored.
» Scope Reference level settings (D Selectable Frequency ranges:
Command: 27 19 Data Frequency range (Hz)
[Xix|xix[xio[xix] 01 0.03~ 1.60
) T T T 02 160~ 2.00
N
= L 00= + (plus) 03 200~ 6.00
s % oS 01=—(minus)
92D 04 6.00~ 8.00
§§%§’%§A 05 8.00 ~ 11.00
momoTT ~
== 38 o9 06 11.00 ~ 15.00
—~ = o . Qi
co 2 «oc ok 07 15.00 ~ 20.00
Adjustable range: —20.0 dB ~ +20.0 dB 08 20.00~ 22.00
in0.5dB steps_ 09 22.00 ~ 26.00
10 26.00 ~ 30.00
11 30.00 ~ 45.00
12 45.00 ~ 60.00
13 60.00 ~ 74.80
14 74.80 ~ 108.00
15 108.00 ~ 137.00
16 137.00 ~ 200.00
17 400.00 ~ 470.00

(2 Selectable Edge number: 01=1, 02=2, 03=3
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